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Einleitung 
Wir freuen uns, dass Sie sich für den BRESSER REX-II 3D-Drucker 

entschieden haben. Wir versichern Ihnen, dass dieser nach neuesten Technik- 

und Sicherheitsstandards produziert wurde. Jedes Gerät wird vor der 

Auslieferung einer ausführlichen Qualitätskontrolle unterzogen, damit einem 

problemlosen Betrieb nichts im Wege steht.     

Diese Bedienungsanleitung wurde speziell für die Nutzung des REX-II 3D-

Druckers konzipiert. Auch wenn Sie bereits Erfahrung im Umgang mit anderen 

Geräten dieser Art haben oder mit der 3D-Drucktechnologie vertraut sind, ist es 

dennoch wichtig, dieses Handbuch zu lesen, da es viele wichtige Informationen 

über den REX-II 3D-Drucker enthält, mit denen Sie Ihre Kenntnisse im Bereich 

des 3D-Drucks erweitern können.  

Wir empfehlen Ihnen außerdem die folgenden Unterlagen für eine optimale 

Druckvorbereitung: 

(1) BRESSER REX-II Schnellstartanleitung 

Die Schnellstartanleitung ist im Lieferumfang des Druckers enthalten. Mithilfe 

der darin enthaltenen Informationen können Sie in kürzester Zeit mit dem 

Drucken beginnen. 

(2) BRESSER REX-II Produktseite im Internet     

Auf der Produktseite im Internet unter www.bresser.de/P2010200 finden Sie 

zusätzliche Informationen, verfügbare Updates oder Software zu diesem 

Drucker sowie zu passendem Zubehör. 

http://www.ff3dp.com/
http://www.bresser.de/P2010200
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Allgemeine Informationen 

Wichtige Hinweise: 

 

 

 

 

 

In dieser Bedienungsanleitung sind alle Informationen enthalten, die für die 

Einrichtung und den Betrieb des Geräts erforderlich sind. 

Die Bedienungsanleitung setzt sich aus den folgenden Teilen zusammen: 

Einleitung, Allgemeine und Sicherheitsinformationen, Bedienung und 

Produktservice. 

Bei Service-Anfragen bitte bereithalten: 

Artikelnr.: 2010200 
Produktbez.: BRESSER REX II 3D-Drucker 
Anleitung:  
Manual_2010200_3D-Drucker-REX-II_de_BRESSER_v052020a.docx 

 

 

 

 

• Lesen Sie diese Bedienungsanleitung vor der Benutzung des Geräts 

aufmerksam durch. 

• Die Bedienungsanleitung setzt die Verwendung des Betriebssystems 

Windows 7 für den Betrieb des 3D-Druckers voraus.  

• Es wird die aktuelle Version der REXprint-Software verwendet. 
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Sicherheitshinweise 
HINWEIS! 

Machen Sie sich mit diesem Handbuch vertraut und lesen Sie alle enthaltenen 

Anweisungen, bevor Sie mit der Einrichtung und dem Betrieb des Geräts 

beginnen. Wenn Warnungen und Anweisungen nicht berücksichtigt werden, 

kann dies zu Verletzungen von Personen, zu Feuer sowie zu einer 

Beschädigung des Geräts oder anderer Gegenstände führen. 

BEFOLGEN SIE ZU JEDER ZEIT STRIKT ALLE IN DESEM HANDBUCH 

AUFGEFÜHRTEN SICHERHEITS- UND SONSTIGEN HINWEISE! 

  

Sicherheit in der Arbeitsumgebung 
① Halten Sie den Arbeitsplatz sauber! 

② Betreiben Sie den 3D-Drucker nicht, wenn brennbare Flüssigkeiten, Gase 

oder Staub vorhanden sind. 

③ Halten Sie Kinder und ungeschulte Personen vom 3D-Drucker fern. 

 

Sicherheit bei der Stromversorgung 
① Betreiben Sie den 3D-Drucker nur über eine geerdete Steckdose. Nehmen 

Sie keine Veränderungen am Netzstecker des 3D-Druckers vor. 

② Betreiben Sie den 3D-Drucker nicht in dunstiger oder feuchter Umgebung. 

Setzen Sie den 3D-Drucker keiner direkten Sonneneinstrahlung aus. 
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③ Nutzen Sie das Netzkabel nicht für einen anderen als den vorgesehenen 

Zweck.  

④ Betreiben Sie das Gerät nicht während eines Gewitters. 

⑤ Um Unfälle zu vermeiden, trennen Sie das Gerät von der 

Stromversorgung, falls Sie es für einen längeren Zeitraum nicht benutzen. 

 

• Sicherheit von Personen 

① Berühren Sie während des Druckens nicht die Düse oder die Druckplatte. 

② Berühren Sie die Düse nach Abschluss des Druckvorgangs nicht. 

③ Tragen Sie geeignete Kleidung. Tragen Sie keine weite Kleidung oder locker 

sitzenden Schmuck. Achten Sie darauf, dass Sie mit Ihren Haaren, der 

Kleidung und Handschuhen nicht in die Nähe der beweglichen Teile 

kommen. 

④ Betreiben Sie das Gerät nicht, wenn Sie müde sind oder unter dem Einfluss 

von Drogen, Alkohol oder Medikamenten stehen. 

 

• Vorsichtsmaßnahmen 

① Lassen Sie das Gerät nicht für längere Zeit unbeaufsichtigt. 

② Nehmen Sie keine Veränderungen am Gerät vor. 

③ Senken Sie die Druckplatte ab, bevor Sie Filament einsetzen/entnehmen. 
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(Der Abstand zwischen Düse und Druckplatte sollte mindestens 50 mm 

betragen.) 

④ Betreiben Sie das Gerät in einer gut belüfteten Umgebung. 

⑤ Nutzen Sie das Gerät nicht für unrechtmäßige Zwecke. 

⑥ Nutzen Sie das Gerät nicht, um Behälter zur Aufbewahrung von 

Lebensmitteln herzustellen. 

⑦ Nutzen Sie das Gerät nicht, um elektrische Geräte herzustellen. 

⑧ Nehmen Sie Modelle nicht in den Mund. 

⑨ Entnehmen Sie die Modelle nicht mit Kraftanwendung. 

⑩ Verbinden Sie das Gerät nicht mit einem Netzwerkkabel, das länger als 

3 m ist. 

  

• Umgebungsbedingungen 

Temperatur: Raumtemperatur 15-30℃ 

Feuchtigkeit: 20 %-70 % 

 

• Filament-Vorgaben 

Filament nur für den vorgesehenen Zweck nutzen! Nur das BRESSER Filament 

oder Filament der von BRESSER anerkannten Marken verwenden! 
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• Filament-Aufbewahrung 

Bei allen Polymeren lässt sich im Lauf der Zeit ein gewisser Zerfall feststellen. 

Packen Sie das Filament erst dann aus, wenn Sie es benötigen. Das Filament 

sollte in einer sauberen und trockenen Umgebung und vor Sonneneinstrahlung 

geschützt aufbewahrt werden. 

 

Rechtlicher Hinweis 

Alle Informationen in diesem Dokument können ohne vorherige Ankündigung 

erweitert oder angepasst werden. 

DIE BRESSER GMBH ÜBERNIMMT KEINE GEWÄHRLEISTUNG IM 

HINBLICK AUF DIESES DOKUMENT, EINSCHLIESSLICH, JEDOCH OHNE 

BESCHRÄNKUNG AUF DIE IMPLIZIERTE GEWÄHRLEISTUNG DER 

MARKTFÄHIGKEIT UND EIGNUNG FÜR EINEN BESTIMMTEN ZWECK. 

Die BRESSER GmbH übernimmt ferner keine Haftung für in diesem Handbuch 

enthaltene Fehler, für zufällige Folgeschäden in Verbindung mit der Lieferung, 

der Leistung oder der Verwendung dieses Materials. 

 

EG-KONFORMITÄTSERKLÄRUNG  
Eine „Konformitätserklärung“ in Übereinstimmung mit den anwendbaren 

Richtlinien und entsprechenden Normen ist von der < Bresser GmbH > erstellt 

worden. Der vollständige Text der EG-Konformitätserklärung ist unter der 

folgenden Internetadresse verfügbar: 

www.bresser.de/download/2010200/CE/2010200_CE.pdf 
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Dieses Dokument enhält durch Urheberrechte geschützte Informationen. 

Copyright © 2020 BRESSER GmbH. Alle Rechte vorbehalten.  

Die Reproduktion dieser Dokumentation – auch auszugsweise – in irgendeiner Form 
(z.B. Fotokopie, Druck, etc.) sowie die Verwendung und Verbreitung mittels 
elektronischer Systeme (z.B. Bilddatei, Website, etc.) ohne eine vorherige schriftliche 
Genehmigung der BRESSER GmbH ist nicht gestattet. 

Die in dieser Dokumentation verwendeten Bezeichnungen und Markennamen der 
jeweiligen Firmen sind im Allgemeinen in Deutschland, der Europäischen Union 
und/oder weiteren Ländern waren-, marken- und/oder patentrechtlich geschützt. 
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Kapitel 1: 3D-Drucktechnologie 
Beim 3D-Druck werden dreidimensionale Modelle in physische Objekte 

verwandelt, die Sie berühren und in die Hand nehmen können. Diese Druckform 

wird auch als additive Herstellung bezeichnet, da das 3D-Modell erstellt wird, 

indem so viele Schichten aufgetragen werden, bis das Objekt vollständig 

geformt ist. 

Die Schmelzschichtung (Fused Filament Fabrication, FFF) ist die häufigste 

Methode des 3D-Drucks, die auch von diesem 3D-Drucker eingesetzt wird. Bei 

dieser Druckmethode wird ein Kunststoff, das Filament, bei hoher Temperatur 

geschmolzen und auf eine Druckoberfläche aufgebracht. Das Filament 

verfestigt sich während des Abkühlens, also praktisch unmittelbar nach dem 

Austritt aus der Düse. 3D-Objekte werden dadurch geformt, dass das Filament 

in mehreren Schichten übereinander aufgetragen wird. 

 

1.1 Verfahren 
Der 3D-Druck umfasst drei Schritte:  

1.) Erstellen oder Herunterladen eines 3D-Modells 

2.) In Scheiben Schneiden und Exportieren des 3D-Modells 

3.) Aufbauen des 3D-Modells 

 

1.1.1 Erstellen eines 3D-Modells:  
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Derzeit bestehen drei Möglichkeiten zum Erstellen eines 3D-Modells: 

• Von Grund auf Entwerfen Sie können kostenfreie CAD-Software (Computer-

Aided Design) wie beispielsweise 3DTADA, AutoCAD, SolidWorks, Pro-E oder 

unsere eigene Software Happy 3D nutzen, um ein eigenes 3D-Modell zu 

entwerfen.  

• 3D-Scanner Alternativ zum Erstellen eines 3D-Modells können Sie auch ein 

Objekt scannen. Ein 3D-Scanner digitalisiert ein physisches Objekt, indem er 

die geometrischen Daten des Objekts erfasst und in einer Datei auf dem 

Computer speichert. Es besteht auch die Möglichkeit, ein Mobilgerät mithilfe 

einer App als 3D-Scanner zu verwenden. 

• Aus der Cloud Die derzeit am weitesten verbreite Methode zum Beschaffen 

eines 3D-Modells, besteht darin, ein 3D-Modell von einer Website 

herunterzuladen, auf die Benutzer ihre eigenen 3D-Modelle hochladen können. 

Beispiel: www. thingiverse.com 

 

1.1.2 Slicing und Export eines 3D-Modells: 

Mit einer Slicer-Software werden 3D-Modelle für den Druck vorbereitet und in 

Anweisungen für den 3D-Drucker umgewandelt. REXprint ist die Slicer-software 

für diesen 3D-Drucker. Mit REXprint können STL-Dateien in G- oder GX-

Dateien für den Druck umgewandelt werden. Mittels USB-Kabel, USB-Stick 

oder per W-LAN werden diese dann zum 3D-Drucker übertragen. 
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1.1.3 Aufbau des 3D-Modells 

Nachdem die Ausgabedatei an den 3D-Drucker übertragen wurde, beginnt 

dieser damit, das 3D-Modell in ein physisches Objekt zu übertragen, indem er 

Schichten von Filament übereinander aufträgt. 
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Kapitel 2:  
Informationen zum 3D-Drucker 
2.1 Informationen zum 3D-Drucker 
2.1.1 Teileübersicht 

          

                                    

 

                           

                                                    

 

 

 

  

1. Touchscreen    

2. Touchscreen-Taste     

3. Düse 

4. Führungsstange der Z-Achse 

5. Druckplatte   

    

11. Ethernet-Eingang 

12. Eingang USB-Kabel  

13. Eingang USB-Stick  

14. Filament-Sensor  

15. Netzschalter 

16. Stromaufnahme 

6. Nivellierungsknopf   

7. Extruder 

8. Führungsstange der X-Achse   

9. Filament-Zufuhr  

10. Federspanner  
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2.1.2 Begriffe 

Druckplatte 
Die Oberfläche, auf der der 3D-Drucker ein Objekt 
aufbaut. 

Druckfolie 

Die blaue Folie, die die Druckplatte des 3D-Druckers 
bedeckt, damit eine optimale Haftung des Objekts auf 
der Druckplatte gewährleistet ist. 

Druckvolumen 

Dreidimensionaler Umfang, den ein Objekt nach 

Fertigstellung einnimmt. Das maximale Druckvolumen 

des 3D-Druckers beträgt 280 x 250 x 300 mm. 

Nivellierungsknöpfe 
Knöpfe unter der Druckplattform, über die der Abstand 

zwischen Düse und Druckplatte eingestellt wird. 

Extruder 

Bauteil, das das Filament von der Spule zieht, es 
schmilzt und dann durch eine Düse auf die Druckplatte 
aufträgt.  

Düse 

Die Düse wird auch als „Druckkopf“ bezeichnet und 

befindet sich unten am Extruder, wo das erhitzte 

Filament herausgepresst wird. 

Extruder-Lüfter 
Für die Kühlung der äußeren Teile des Extruders und 

Getriebemotors. 

Filament-Zufuhr 
Eine Öffnung, die sich auf der Oberseite des Extruders 

befindet. 

Filament-Führungsrohr 
Ein schwarzes Kunststoffteil, das das Filament vom 

Filament-Behälter bis zur Zufuhr leitet.  

Filament-Behälter Eine Box zum Unterbringen des BRESSER-Filaments. 
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2.1.3 Gerätedaten 
Name REX-II 

Anzahl an Extrudern 1 

Drucktechnologie 
Schmelzschichtung (Fused Filament Fabrication, 

FFF) 

Displaygröße 12,7cm (5“) IPS-Farb-Touchscreen  

Druckvolumen 280 x 250 x 300 mm 

Schichtauflösung 0,05-0,4 mm 

Druckgenauigkeit ±0,1 mm 

Positioniergenauigkeit Z-Achse: 0,0025 mm, XY-Achse: 0,011 mm 

Filament-Durchmesser 1,75 mm (±0,07) 

Düsendurchmesser 0,4 mm 

Druckgeschwindigkeit 30~150 mm/s 

Software REXprint 

PVP-Klebestift 
Ein fester Klebstoff, der benutzt wird, damit das Modell 

fest auf der Platte klebt. 

Reinigungswerkzeug 
Ein Werkzeug zum Beseitigen von Verstopfungen und 

Reinigen des Extruders.  

Gabelschlüssel 
Ein Werkzeug zum Greifen des Metallwürfels der 

Düse. 



 

 

 www.bresser.de  

 
18 

Unterstützte Dateiformate 

Eingabe: 
3MF/STL/OBJ/FPP/BMP/PNG/JPG/JPEG 

Ausgabe: GX/G 

Betriebssystem Windows XP/Vista/7/8/10、Mac OS、Linux 

Geräteabmessungen 490 x 550 x 560 mm 

Nettogewicht 30 kg 

Wechselstrom- 
Eingangsspannung 

Eingangsspannung: 100-240 VAC, 47-63 Hz, 
Leistung: 500 W 

Anschlüsse USB-Kabel, USB-Stick, W-LAN, Ethernet 
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2.1.4 Touchscreen-Menüs 

 

„Build“ 

 

 

Lesen der Druckdatei von 

 der lokalen Speicherkarte 

 dem USB-Stick 

 Pfeil zurück 

 

Wählen Sie die gewünschte Druckdatei 
aus der Liste. 

 „Build“: Zum Starten des Drucks 

„Copy“: Zum Kopieren der Dateien 
vom USB-Stick auf die lokale 
Speicherkarte. (Die Schaltfläche ist 
beim Drucken von der lokalen 
Speicherkarte nicht verfügbar.) 

 „Delete“: Zum Löschen der Druckdatei 
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Druckmenü 

 „Abort“: Zum Abbrechen des 
Druckauftrags 

 „Pause/Resume“: Zum 
Unterbrechen/Wiederaufnehmen des 
Druckauftrags 

„More“: Zum Wechseln von Filament 
und Einrichten der automatischen 
Abschaltung während des Druckens 

 

 

 

 

Tools des Druckmenüs 

„Filament“: Zum Wechseln des 
Filaments während des Druckens.  

(Hinweis: Der laufende Betrieb muss 
erst unterbrochen werden.) 

 „Cancel“: Zum Beenden der Tools und 
zum Zurückkehren zum Druckmenü 

 

„Preheat“ 
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Tippen Sie auf die Schaltfläche 
[Preheat], um das Menü für das 
Aufwärmen zu öffnen. Tippen Sie auf 
die Schaltfläche [Start], um den 
Aufwärmvorgang bis zur festgelegten 
Temperatur zu starten. 

Die Standardtemperatur beträgt 220℃. 

Tippen Sie zum Festlegen der 
Temperatur auf den Balken auf der 
Anzeige.  

 

Legen Sie die Aufwärmtemperatur wie 
folgt fest:  

Tippen Sie auf [Yes], um die Einstellung 
zu speichern, oder tippen Sie auf [No], 
um die Einstellung abzubrechen.  
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Auf dem Bild wird das Menü für das 
Aufwärmen dargestellt. Es werden die 
aktuelle Temperatur sowie die 
Zieltemperatur angezeigt. Tippen Sie auf 
die Schaltfläche [Abort], um den 
Aufwärmvorgang abzubrechen. 

 

„Tools“ 

 

 

Tippen Sie auf [Tools], um die Optionen 
für die Tools aufzurufen. 

 „Filament“: Zum Einsetzen/Entnehmen 
von Filament. 

 „Level“: Zum Verstellen der Druckplatte 

 „Home“: Zum Wiederherstellen des 
Nullpunkts für die X-, Y- und Z-Achsen 

 „Manual“: Zum manuellen Anpassen 
der X-, Y- und Z-Achsenpositionen 

„Setting“: Zum Einrichten wichtiger 
relevanter Funktionen  

„Status“: Zum Prüfen des Druckerstatus 
in Echtzeit  

 „About“: Informationen zum Drucker. 
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 Pfeil zurück 

 

 

Manuelle Anpassung 

 „Y+“: Der Extruder bewegt sich zum 
Nullpunkt, d. h. zur Rückseite des 
Geräts. 

 „Y-“: Der Extruder bewegt sich in die 
der „Y+“-Position entgegengesetzte 
Richtung.  

 „X+“: Der Extruder bewegt sich zum 
Nullpunkt, d. h. nach rechts. 

„X-“: Der Extruder bewegt sich in die der 
„X+“-Position entgegengesetzte 
Richtung. 

 „Z+“: Die Druckplatte bewegt sich nach 
oben. 

 „Z-“: Die Druckplatte bewegt sich nach 
unten. 

 Pfeil zurück 

 

 

Tippen Sie auf [Setting], um in das 
Menü für die Einstellungen zu 
gelangen. 

 „Language“: Zum Festlegen der 
Displaysprache 

 „Resume Print“: Zum 
Wiederaufnehmen des Druckvorgangs 
nach einem Neustart des Guider II 

 „WiFi“: Zum Ein-/Ausschalten des W-
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LAN 

 „WLan hotspot“: Zum Ein-
/Ausschalten des W-LAN-Hotspots 

„Extruder Calibration“: Zum Einstellen 
des Anfangsabstands zwischen 
Extruder und Druckplatte 

„Filament Check Off“: Zum Ein-
/Ausschalten der Filament-Prüfung 

 „Factory Reset“: Zum 
Wiederherstellen der 
Werkseinstellung 

„Update“: Zum Aktualisieren der 
Firmware-Version 

Pfeil zurück 

 

 

„WiFi“: 

Einschalten des W-LAN: Schalten Sie 
das W-LAN ein, geben Sie den W-
LAN-Hotspot frei und legen Sie das W-
LAN am Computer fest 

Pfeil zurück 
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„WLAN hotspot“ 

Ein/Aus: Zum Ein-/Ausschalten des W-
LAN-Hotspots 

„Setup WLAN hotspot“: Zum Festlegen 
der SSID und des Kennworts 

„SSID name“: Der Name des Hotspots 

„Password“: Das Kennwort des 
Hotspots 

„Save“: Zum Speichern der Einstellung 

Pfeil zurück 

 

 

„Status“: 

Zeigt den Status der Extrudertemperatur 
in Echtzeit an  

 

„About“: 

Zeigt die grundlegenden Informationen 
zum Gerät an 
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2.2 Zubehör 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                            

   Filament-Spule        Stromkabel         USB-Kabel     Filament-Führungsrohr    

  

                                          

   Schnellstartanleitung      USB-Stick     Schraubendreher   Inbusschlüssel (M2,0/2,5)  

                                     

                     

      Klebestift      Maulschlüssel       Stiftwerkzeug       Garantie & Service-Karte 
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Kapitel 3: Auspacken 
In diesem Kapitel wird beschrieben, wie Sie den 3D-Drucker vollständig 

auspacken.  

 

3-1 

(3-1) Die Verpackung auf einer saubere, ebene Arbeitsfläche stellen. 

 

 

 

 

 

 

(3-2) Die Verpackung öffnen und die beiden Styroporteile entnehmen. Den 3D-
Drucker vorsichtig aus der Verpackung heben. 

 

 

 

3-2 
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(3-3) Die Verpackungsmaterialien sorgfältig vom 3D-Drucker entfernen. 

 

 

     

 

 

 

(3-4) Unten in der Verpackung befinden sich eine Spule mit Filament, ein 
Spulenhalter, ein Stromkabel, ein USB-Kabel, ein Filament-Führungsrohr, ein 
Klebestift sowie eine Werkzeugtasche (Inhalt: 1x USB-Stick, 2x 
Inbusschlüssel, 1x Maulschlüssel, 1x Stiftwerkzeug, 1x Schraubendreher). 

Die Styroporteile zum Schutz der Seiten entfernen. 

(3-5) Kunststoffbeutel entfernen, um den 3D-Drucker freizulegen. 

 

 

3-3 

   

 

3-4 
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(3-6) Die oberen Styroporteile vom Drucker entfernen. Darin befinden sich die 
Schnellstartanleitung sowie die Garantie & Service-Karte. 

 

(3-7) Schneiden Sie die vier Bänder durch, die die Führungsstange fixieren.  

 

 

 

(3-7) Die vier Transportsicherungsbänder durchtrennen, die die 
Führungsstange fixieren. Dann den Extruder vorsichtig hin- und herschieben, 
um sicherzustellen, dass er sich in ordnungsgemäßem Zustand befindet. 

 

                                      

 

 

 

 

 

(3-8) Die obere Druckerabdeckung herausnehmen. 

 

                                  3-6 

 

3-8 

 

                                  3-7 
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Herzlichen Glückwunsch! Ihr 3D-Drucker ist nun vollständig ausgepackt. Im 
nächsten Kapitel werden die einzelnen Aufbauschritte des 3D-Druckers 
beschrieben. 

 

 

                                 3-9 
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Kapitel 4: Hardwareaufbau 
Der 3D-Drucker wurde bereits im Werk vorinstalliert, d. h. Sie können damit 

direkt drucken, nachdem Sie die Filament-Spule eingesetzt haben und die 

Nivellierung abgeschlossen ist. 

4.1 Filament-Installation 
 

 

 

 

 

                                    4-1                                          

(4-1) Der Filament-Behälter befindet sich an der Rückseite des Druckers. Den 

Behälter aus dem Drucker entnehmen.  

(4-2) Etwa 20cm des Filaments abwickeln und wie abgebildet von unten durch 
das Element für die Filament-Erkennung führen.  

   

Filament-Erkennung (Pfeil) 
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4.2 Starten des Druckers 
                                          

              

4-3 

(4-3) Das Stromkabel in die Anschlussbuchse (B) auf der Rückseite des 
Druckers stecken. Den Netzstecker in die Steckdose stecken. Den Ein/Aus-
Schalter (A) in die Position ‚I‘ bewegen, um das Gerät einzuschalten.  

 

4.3 Einsetzen des Filaments 
Damit das Filament festsitzt und das Gerät keinen Schaden nimmt, muss das 
Filament-Führungsrohr richtig eingesetzt werden.   

 

 

 

 

4-4 

(4-4) Das Filament aus dem Element für die Filament-Erkennung heraus durch 
das Filament-Führungsrohr schieben.   
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(4-6) Das Filament etwa 2 cm aus dem Filament-Führungsrohr herausziehen. 

Hinweis: Die Druckplattform absenken, so dass der Abstand zwischen 
Düse und Druckplattform mindestens 50 mm beträgt, um einen Stau an 
der Düse zu vermeiden. 

 

 

 

 

(4-7) Auf [Tools] tippen. 

 

 

  

 

(4-8) Auf [Filament] > [Load] tippen. 

 

 

    

 

4-6 
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4-9 

(4-9) Nachdem der Extruder eine Temperatur von 220℃ erreicht hat, ertönt ein 
Druckersignalton als Aufforderung, das Filament in den Extruder einzuführen. 

 

 

                                    4-10 

(4-10) Das Filament wie abgebildet senkrecht in die Filament-Zufuhr einführen. 
Das Filament wird dann vom Extruder eingezogen.  

Hinweis: Nicht auf [Cancel] tippen, bis das Filament ein Stück weit in den 
Extruder eingezogen wurde. 
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4.4 Entfernen des Filaments 

 

 

    

 

4-11 

(4-11) Auf [Tools] > [Upload] tippen. Der Aufwärmvorgang des Extruders wird 

daraufhin gestartet.         

 

 

 

 

 

 

 

 

 

 

                                4-12 

(4-12) Nachdem der Extruder eine Temperatur von 220℃ erreicht hat, ertönt ein 

Druckersignalton als Aufforderung, das Filament aus dem Extruder zu entfernen. 

Den Federspanner drücken, das Filament für etwa drei Sekunden nach unten 

drücken und dann das Filament vorsichtig herausziehen. 
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Hinweis: Das Filament nicht gewaltsam herausziehen, da dies zu einer 

Beschädigung der Zahnräder führen kann. Wenn das geschmolzene 

Filament im Extruder abgekühlt ist, die oben beschriebenen Schritte ggf. 

wiederholen. 
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Kapitel 5:  
Nivellieren der Druckplattform 

Der 3D-Drucker verwendet ein intelligentes Drei-Punkt-Nivellierungssystem mit 
eindeutiger und nachvollziehbarer Rückmeldung für den Benutzer. Unter der 
Druckplattform befinden sich drei federgespannte Knöpfe. Der Abstand 
zwischen der Platte und der Düse vergrößert sich, wenn die Spannung an den 
Knöpfen vergrößert wird. Ein Lösen der Spannung führt zu einer Verringerung 
dieses Abstands. 
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(5-1) Auf dem Touchscreen des 3D-Druckers auf [Tools] > [Level] tippen. 
Warten, bis die ersten Bewegungen des Extruders und der Plattform 
abgeschlossen sind. Weitere Anweisungen am Touchscreen befolgen. 

 

                               

 

 

 

5-2 

(5-2) Nach Antippen von [Yes] bewegt sich der Extruder auf die Startposition 
und die Platte bewegt sich nach oben und unten, um den Abstand zwischen 
Düse und Plattform nochmals zu prüfen.  

 

 

 

 

 

 

 

(5-3) Wenn sich der Abstand als zu groß erweist, lösen Sie die entsprechende 
Mutter unter der Plattform im Uhrzeigersinn, bis ein durchgängiger Signalton 
erklingt und die Schaltfläche [Verify] angezeigt wird. 

 

 

 

Z  

5-3 
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(5-4) Wenn der Abstand passend ist, auf [OK] tippen, um die Nivellierung des 
zweiten Punktes vorzunehmen. Sofern der Abstand noch immer nicht passend 
ist, die weiteren Aufforderungen befolgen, um eine weitere Anpassung 
vorzunehmen, bis die Schaltfläche [OK] angezeigt wird. 

 

 

 

 

 

(5-5) Die Schritte 2 bis 4 wiederholen, um die Nivellierung des zweiten und 
dritten Punkts abzuschließen. Anschließend auf [Finish] tippen, um die 
Anpassung zu beenden. 

 

Notfallplan für die Nivellierung: 
Einige Nivellierungselemente können nach einer gewissen Nutzungszeit 
Beschädigungen aufweisen. Ist das der Fall, kann auf den Notfallplan für die 
Nivellierung zurückgegriffen werden. 

（1）Den USB-Stick in den dafür vorgesehenen USB-Port stecken. 

（2）Jeden der drei Knöpfe unter der Plattform so fest wie möglich anziehen. 

（3）Auf dem Touchscreen auf [Build] und dann auf das USB-Symbol tippen. 

 

5-5 

 

5-4 
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Die Datei „Leveling.g“ auswählen. 

（4）Tippen Sie auf [Build]. Die Druckplatte und der Extruder beginnen sich 
dann zu bewegen. 

（5）Nachdem diese Bewegungen abgeschlossen sind, kann der Abstand 
zwischen Druckplattform und Düse manuell angepasst werden. Dazu den 
Extruder bis über den vorderen linken Knopf bewegen und den Knopf 
entsprechend verstellen. Mit einem Papier im A4-Format den Abstand prüfen. 
Beim Verstellen des Knopfs sicherstellen, dass sich das Papier zwischen Düse 
und Druckplattform bewegen lässt. Es darf eine gewisse Reibung am Papier 
entstehen, aber es muss einfach zwischen Platte und Düse durchgeführt 
werden können, ohne dass es dabei reißt oder beschädigt wird. 

（6）Fahren Sie dann mit den Positionen direkt über dem vorderen rechten und 
dem hinteren Knopf fort und passen Sie den Abstand wie oben beschrieben an.  

（7）Bringen Sie als Nächstes den Extruder in die Position mittig über der 
Druckplatte, um die Einstellungen zu prüfen. Stellen Sie sicher, dass das Papier 
zwischen Düse und Platte mit einer moderaten Reibung durchgezogen werden 
kann. 

（8）Auf die Schaltfläche „Abbruch“     tippen und die Nivellierung 
abschließen. 
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Kapitel 6:  
Informationen zur Software 

 
6.1 Softwareinstallation 
6.1.1 Beschaffen der Software 
 

Methode 1: USB-Stick 

Das vollständige Installationspaket befindet sich auf dem USB-Stick, der im 
Lieferumfang enthalten ist: 

 

 

 

Methode 2: Internet-Download 

Die Produktseite des 3D-Druckers im Internet über folgenden Link aufrufen:      

http://www.bresser.de/P2010200   

Die Software-Pakete sind unter dem Reiter „Downloads“ zu finden und können 
von dort heruntergeladen werden. 

 

6.1.2 Installieren und Einrichten der 
Software 
1. ZIP-Datei extrahieren (Mac) oder das Installationsprogramm per Doppelklick 
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starten (Win). Den Anweisungen zur Installation der Software folgen. 

2. Die Software über das Startmenü starten oder durch Anklicken des Software-

Symbols. (siehe 6-1) 

 

 

                                    6-1 

6.2 Erste Schritte mit REXprint 
6. 2.1 Auswählen des Gerätetyps 
Nach dem Start von REXprint den Gerätetyp auswählen. 

Beim Starten von REXprint wird ein Dialogfeld geöffnet. Aus der Liste der 

Gerätetypen „BRESSER REX-II“ wählen und auf [OK] klicken. Der Gerätetyp 

kann auch über das Software-Menü [Print] > [Machine type] geändert 

werden. (siehe 6-2) 

 

 

 

 

 

 

6-2 
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6.2.2 Erste Schritte mit der Software 
 

 

 

 

 

 

 

 

 

 

 

 

 
Eine oder mehrere Dateien laden 

 
In den Stützen-Bearbeitungsmodus wechseln 

 
Direkt über den 3D-Drucker drucken oder Dateien auf den USB-

Stick exportieren 

 
Den REXprint-Startbildschirm aus einem der sechs 
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Ansichtswinkel betrachten 

 
Sich auf der XY-Ebene um das Modell herum bewegen, 

Umschalttaste drücken und klicken, um sich auf der Z-Achse zu 

bewegen 

 
Das Modell drehen und rotieren 

 
Die Objektgröße skalieren 

 
Modell in mehrere Teile schneiden 

 

6.2.3 Laden 

Es stehen sechs Möglichkeiten zur Verfügung, um eine Modelldatei oder 
Gcode-Datei in REXprint zu laden:  

Methode 1: Im Hauptmenü auf das Symbol „Load“      klicken. Gewünschte 
Objektdatei wählen.  

Methode 2: Gewünschte Objektdatei in das Programmfenster ziehen. 

Methode 3: Auf [File] > [Load File] klicken. Gewünschte Objektdatei wählen. 

Methode 4: Auf [File] > [Examples] klicken, um Beispieldateien zu laden. 

Methode 5: Auf [File] > [Recent Files] klicken, um die zuletzt geöffneten 
Dateien zu laden. 
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Methode 6: Gewünschte Objektdatei wählen und auf das REXprint-Symbol 
ziehen. 

Hinweis: REXprint unterstützt die Bearbeitung von 3D-Modellen in den 
folgenden Formaten: .STL, .OBJ und .FPP. 

 

Gestalten von Reliefs 
Laden Sie eine Bilddatei im Format PNG, JPG, JPEG oder BMP in REXprint. 
Daraufhin wird das folgende Dialogfeld (6-3) geöffnet. In diesem Dialogfeld 
können Sie Einstellungen für die Form, den Modus, die maximale Stärke, die 
Grundstärke, die untere Stärke, Breite und Höhe, den Durchmesser oben und 
den Durchmesser unten festlegen.  

„Shape“: umfasst die Formen „Plane“, „Tube“, „Canister“ und „Lamp“.  

„Mode“: umfasst „darker is higher“ und „lighter is higher“. 

„Maximum Thickness“: Z-Wert des Modells 

„Base Thickness“: Die Mindeststärke der Grundplatte, der Standardwert ist auf 
0,5 mm festgelegt. 

„Width“: X-Wert des Modells 

„Depth“: Y-Wert des Modells 

„Bottom Thickness“: Zum Festlegen der unteren Stärke für die Formen „Tube“, 
„Canister“ und „Lamp“ 

„Top Diameter“: Zum Festlegen des oberen Durchmessers für die Formen 
„Tube“, „Canister“, „Lamp“ und „Seal“ 

„Bottom Diameter“: Zum Festlegen des unteren Durchmessers für die Formen 
„Tube“, „Canister“, „Lamp“ und „Seal“ 
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 6-4 

 Plane (6-5) 

  

  

 

 

 

 

 

Tube (6-6) 
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Canister (6-7) 

 

 

 

 

 

 

 

 

                              Lamp (6-8) 
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                               Seal (6-9) 

 

6.2.4 Ansichten 
① Ändern von Ansichten 
Ändern Sie die Modellansichten durch Bewegen, Drehen und Skalieren. 

● Ziehen 

Auf das Symbol „View“  klicken. Das Objekt kann dann anhand einer 
der folgenden drei Methoden bewegt werden: 

Methode 1: Bei gedrückter linker Maustaste ziehen. 

Methode 2: Bei gedrückter mittlerer Maustaste ziehen. 

Methode 3: Bei gedrückter Umschalttaste und gleichzeitig gedrückter rechter 
Maustaste ziehen.  

● Drehen 

Auf das Symbol „View“  klicken. Das Objekt kann dann anhand einer 
der folgenden zwei Methoden gedreht werden: 
Methode 1: Halten Sie die rechte Maustaste gedrückt, und ziehen Sie. 
Methode 2: Umschalttaste und linke Maustaste gedrückt halten und ziehen. 
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● Skalieren 
Das Mausrad drehen, um die Druckplatte zu vergrößern oder zu verkleinern.   
 

② Festlegen der Ansicht 
Der Benutzer kann das Objekt auf der Druckplatte betrachten. Im Ansichtsmenü 
stehen sechs Ansichten zur Verfügung, d. h. die Startansicht, die Ansicht von 
unten, von oben, von hinten, von vorne, von links und von rechts.  

Methode 1: Auf die Schaltfläche  [View] klicken. Daraufhin werden in der 
Dropdown-Liste sechs Ansichten aufgeführt.  

Methode 2: Auf die Schaltfläche  [View] klicken und klicken dann erneut 
klicken, um ein Untermenü zu öffnen, in dem die sechs Ansichten zur Auswahl 
bereitstehen. 
 

③ Zurücksetzen der Ansicht 
Es gibt die folgenden beiden Möglichkeiten, um Ansichten zurückzusetzen: 
Methode 1: Klicken Sie auf den Menü [View], und wählen Sie [Home View]. 

Methode 2: Klicken Sie links auf die Schaltfläche  [View], und klicken Sie 
erneut darauf, um die Anzeigeoptionen anzuzeigen. Sie können dann auf 
[Reset] klicken. 

 

④ Anzeigen des Modellumrisses 

Auf  [View] > [Show Model Outline] klicken. Daraufhin wird die gelbe 
Außenlinie des Objekts hervorgehoben. 

 

⑤ Anzeigen eines steilen Überhangs 

Auf  [View] > [Show Steep Overhang] Klicken. Wenn sich der 
Schnittwinkel zwischen der Modelloberfläche und der horizontalen Linie im 
Bereich des Schwellenwerts für den Überhang befindet, weist die Oberfläche 
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einen steilen Überhang auf und wird in der Software in Rot dargestellt. Der 
Schwellenwert für den Überhang kann nach Bedarf angepasst werden. 
Standardmäßig ist der Wert auf 45° festgelegt. 

 

6.2.5 Bewegen 
Wählen Sie das gewünschte Objekt aus, und bewegen Sie es anhand einer der 
folgenden beiden Methoden: 

Methode 1: Klicken Sie links auf das Symbol  [Move], halten Sie die linke 
Maustaste gedrückt, und ziehen Sie, um die Position des Modells in der XY-
Richtung zu verschieben. Halten Sie die Umschalttaste und die linke 
Maustaste gedrückt, und ziehen Sie, um die Position des Modells in der Z-
Richtung zu verschieben. Der Abstand und die Bewegungsrichtung werden 
angezeigt. 

Methode 2: Klicken Sie links auf die Schaltfläche  [Move], und geben Sie 
dann einen Wert für den Abstand ein. Klicken Sie auf [Reset], um die 
Abstandswerte zurückzusetzen. 

Hinweis: Nach der Positionsanpassung sollte man auf [Center] und [On 
Platform] klicken, um sicherzustellen, dass sich die Modelle im Druckbereich 
und auf der Druckplattform befinden. Wenn eine bestimmte Position erforderlich 
ist, klicken Sie nur auf [On Platform]. 

 

6.2.6 Drehen 
Wählen Sie das gewünschte Objekt aus, und drehen Sie es anhand einer der 
folgenden beiden Methoden:  

Methode 1: Klicken Sie links auf das Symbol  [Rotate]. Daraufhin 
werden drei im rechten Winkel zueinanderstehende Ringe um das Objekt herum 
angezeigt. Klicken Sie auf einen Ring, und nehmen Sie eine Drehung um die 
aktuelle Achse herum vor. Sie können dann den Drehwinkel und die Richtung 
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in der Mitte des Rings sehen. Auf diese Weise können Sie das Modell um die 
X-/Y-/Z-Achsen drehen. 

Methode 2: Klicken Sie links auf das Symbol  [Rotate], und geben Sie 
dann die Drehwinkelwerte für die Positionierung für die X-/Y-/Z-Achsen ein. 
Klicken Sie auf [Reset], um die Drehwinkelwerte zurückzusetzen. 

 

6.2.7 Skalieren 
Wählen Sie das gewünschte Objekt aus, und skalieren Sie es anhand einer der 
folgenden beiden Methoden:  

Methode 1: Klicken Sie links auf das Symbol  [Scale], halten Sie die 
linke Maustaste gedrückt, und skalieren Sie das Modell. Die entsprechenden 
Werte werden neben dem Objekt angezeigt. 

Methode 2: Klicken Sie links auf das Symbol  [Scale], und geben Sie 
dann die Skalierungswerte für die Positionierung für die X-/Y-/Z-Achsen ein. 
Klicken Sie auf die Schaltfläche [Maximum], um die maximal mögliche Größe 
für den Druck zu erzielen. Klicken Sie auf [Reset], um die Größe des Modells 
zurückzusetzen. 

Hinweis: Wenn Sie auf das Optionsfeld [Uniform Scaling] geklickt haben, wird 
das Modell maßstabsgetreu skaliert, wenn Sie einen beliebigen Wert der 
Positionierung des Modells ändern. Anderenfalls wird nur der entsprechende 
Positionswert geändert. 

 

6.2.8 Schneiden 
Klicken Sie mit der linken Maustaste auf das Modell, um es auszuwählen, und 

doppelklicken Sie dann auf das Symbol „Cut“ , um die Schnittebene 

festzulegen. Sie können die Richtung und die Position festlegen. 
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① Mit Maus zeichnen 

 

 

 

 

 

② X-Ebene 

 

 

 

 

③ Y-Ebene 

 

 

 

 

 

④ Z-Ebene 
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6.2.9 Stützen 
Nachdem Sie das Modell geladen haben, klicken Sie auf [Edit] > [Supports] 

oder direkt auf das Symbol  Supports. Sie wechseln dann in den 
Bearbeitungsmodus für Stützen (wie in der Abbildung unten dargestellt). Klicken 
Sie auf [Back], um diesen Modus zu verlassen, wenn Sie die Bearbeitung 
abgeschlossen haben. 

① Stützenoptionen 

Wenn Sie auf „Support Options“ klicken, wird ein Optionsfeld angezeigt, in dem 
die Stützenoptionen „Treelike“ und „Linear“ aufgeführt werden. Wenn Sie die 
Option „Treelike“ auswählen und auf [OK] klicken, wird eine Baumstruktur 
erstellt. Wählen Sie hingegen „Linear“ und klicken dann auf [OK], wird eine 

 

6-10 
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lineare Struktur erstellt. Wenn das Modell bereits über Stützen verfügt und Sie 
eine der Stützenoptionen auswählen, beurteilt die Software, ob die 
vorhandenen Stützen gelöscht werden müssen. Diese Entscheidung erfolgt auf 
Grundlage des ausgewählten Stützentyps. Sie können diese Entscheidung in 
einem Popup-Fenster bestätigen. 

 

 

 

 

 

 

 

 

                               

② Automatische Stützen 
Klicken Sie auf die Schaltfläche [Auto Supports]. Die Software beurteilt die 
Positionen, an denen Stützen erforderlich sind, und erstellt entsprechende 
Stützen im Baumformat oder linearen Format. Bei einem Modell mit Stützen 
werden die vorhandenen Stützen entfernt und neue erstellt. 

③ Hinzufügen von Stützen 
Stützen werden hinzugefügt, wenn Sie auf die Schaltfläche [Add] klicken. 
Positionieren Sie den Mauszeiger an der Stelle, an der eine Stütze erforderlich 
ist, klicken Sie mit der linken Maustaste, um den Anfangspunkt für die Stütze 
auszuwählen, halten Sie die linke Maustaste gedrückt und ziehen Sie die Maus. 
Die Stützenvorschau wird geöffnet (sofern für die Fläche keine Stütze 
erforderlich ist oder der Winkel der Stützsäule zu groß ist, wird das in der 
Stützenansicht hervorgehoben). Lassen Sie die linke Maustaste los. Wenn die 
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Stützsäule für ein Modell nicht geeignet ist, wird die Stütze am Ausgangs- und 
Endpunkt erstellt (durch die hervorgehobene Stütze in der Vorschau wird keine 
Stützstruktur erstellt). 

④ Entfernen von Stützen 
Klicken Sie auf [Clear Supports]. Daraufhin werden alle Stützen gelöscht. 
Diesen Löschvorgang können Sie rückgängig machen, indem Sie auf [Undo] 
klicken oder die Tastenkombination Strg+Z drücken. 

⑤ Löschen von Stützen 

Stützen werden gelöscht, wenn Sie auf die Schaltfläche [Delete] klicken. 

Positionieren Sie den Mauszeiger auf der Stütze, die gelöscht werden soll. Die 

aktuelle Stütze und die zugehörigen Unterknoten werden hervorgehoben. 

Drücken Sie die linke Maustaste, um die hervorgehobene Stütze zu löschen. 
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6.2.10 Drucken 
 

 

 

① Preview: Sie können das Vorschaumenü öffnen. 

② Print When Slice Done: Empfehlung: Bei Druck über USB-Kabel das 
Kontrollkästchen aktivieren; bei Druck von USB-Stick das Kontrollkästchen 
nicht aktivieren. 

③ Material Type: vom Drucker unterstützten Materialtyp wählen. 

④ Supports: Druckobjekte mit „schwebenden“ Elementen benötigen Stützen. 
Auf [Supports] klicken, um für den Druck eine Stütze zu erstellen. 

⑤ Raft: Druckplattformfunktion für eine gute Haftung des Modells auf der 
Plattform. Empfehlung: Bei kleineren Objekten aktivieren. 

⑥ Wall: Nützliche Funktion bei Drucken mit zwei Farben, um das aus einem 
anderen Extruder austretende Filament abzuhalten. 
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⑦ Vase Mode: Vasenmodus wählen, um ein oben offenes Modell zu drucken. 

⑧ Resolution: Wählbare Druckauflösungen: „High“ – hohe Druckqualität, 
geringe Druckgeschwindigkeit; „Standard“ – für die meisten Drucke sinnvolle 
mittlere Qualitätsstufe; „Low“ – niedrige Druckqualität, hohe 
Druckgeschwindigkeit; „Hyper“ – speziell für PLA-Filament. 

⑨ More Options: Auf [More Options] klicken, um weitere Einstellungen für 
Schicht, Hülle, Füllung, Geschwindigkeit und Temperatur vorzunehmen. Für 
unterschiedliche Auflösungen gelten unterschiedliche Standardwerte. Auf 
[Restore Defaults] klicken, um die Standardeinstellung wiederherzustellen. 

● Layers 

a. Layer: Die Stärke einer Schicht für das Druckobjekt. Wenn Sie für die Stärke 
einen niedrigen Wert festlegen, erhalten Sie ein Modell mit einer glatteren 
Oberfläche. 

b. First Layer Height: Die Höhe der ersten Druckschicht ist auch entscheidend 
dafür, wie gut das Modell auf der Plattform haftet. Der Höchstwert beträgt 
0,4 mm, und in der Regel ist die Standardeinstellung völlig ausreichend. 

c. Shell: Umfasst den Wert für die Außenhülle sowie den Wert für die 
Abschlussschicht (für das vasenförmige Muster „Vase“ kann keine 
Einstellung für die obere Schicht vorgenommen werden). 

● Shells 

a. Top Solid Layer: Der Höchstwert für die oberste feste Schicht beträgt 10 und 
der Mindestwert 1. 

b. Bottom Solid Layer: Der Höchstwert für die unterste feste Schicht beträgt 
10 und der Mindestwert 1. 

● Infill   

a. Fill Density bezeichnet die Füllrate. 

b. Fill Pattern bezeichnet das Füllmuster, das sich auf die Dauer des 
Druckvorgangs auswirkt. 

c. Combine Infill: Schichten, die miteinander kombiniert werden sollen, der 
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Schichtstärke entsprechend auswählen. Die kombinierte Stärke sollte den Wert von 
0,4 mm nicht überschreiten. Die Option „Every N layers“ ist für alle Füllungen 
verfügbar, die Option „Every N inner layers“ ist nur für die innere Füllung verfügbar, 
wodurch der Druckvorgang im Allgemeinen verkürzt werden kann.  
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● Speed 

a. Print Speed bezeichnet die Druckgeschwindigkeit, d. h. die 
Geschwindigkeit, mit der sich der Extruder bewegt. In der Regel hängt die 
Druckqualität mit der Geschwindigkeit zusammen, d. h. sie ist bei einem 
hochwertigen Druck langsam. Für den PLA-Druck wird ein Wert von 80 
empfohlen. 

b. Support Print Speed ist erforderlich, wenn Sie die Anwendung Slic3r 
nutzen, um das Modell in mehrere Schichten zu zerlegen, denn über diese 
Option kann die Druckgeschwindigkeit des Extruders beim Drucken der 
Stützen gesteuert werden.  

c. Travel Speed dient der Steuerung der Geschwindigkeit, mit der sich der 
Extruder bewegt, solange nicht gedruckt wird. Für den PLA-Druck wird ein 
Wert von 100 empfohlen. 

Hinweis: Für ein besseres Druckergebnis die Parameter anpassen, da für 
unterschiedliche Modelle verschiedene Parameter erforderlich sind. 

● Temperature 

Extruder Temperature: Für den Extruder wird eine Temperatur von 220℃ 
empfohlen. 

Hinweis: Wird eine andere Temperatur festgelegt, wirkt sich das geringfügig auf 
den Druck aus. Die Temperatur an die Bedingungen anpassen, um ein gutes 
Druckergebnis zu erzielen. 
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● Others 

Pause At Heights: Einstellung für die Höhe, in der der Druck automatisch 
unterbrochen wird. Diese Funktion ist dann hilfreich, wenn an einem bestimmten 
Punkt das Filament gewechselt werden soll. 
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(6-14) Auf [Edit] klicken, um eine Höhe einzufügen oder zu entfernen.  

6.2.11 Dateimenüs 
① New Project 
Klicken Sie auf [File] > [New Project], um ein leeres Projekt zu erstellen. Wenn 
bei einem vorherigen Projekt eine Änderung noch nicht bestätigt ist, werden Sie 
gefragt, ob diese Änderung gespeichert werden soll oder nicht. Klicken Sie auf 
[Yes], um die Änderung zu speichern, oder auf [No], um sie zu verwerfen. Wenn 
Sie auf [Cancel] klicken oder die QuickInfo schließen, wird das neue Projekt 
nicht erstellt. 

 

 

 

 

② Save 

Nachdem das Modell bearbeitet und angepasst wurde, gibt es zwei 
Möglichkeiten, um alle dargestellten Modelle zu speichern. 
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Methode 1: Auf [File]--[Save Project] klicken, um die Datei als Projektdatei mit 
der Dateinamenerweiterung FPP zu speichern. Alle dargestellten Modelle 
(einschließlich Stützen) bleiben voneinander unabhängig. Bei einem erneuten 
Laden der Datei entsprechen die Konfigurationsinformationen für den Extruder 
und die Modellpositionierung der Konfiguration beim Speichern der Datei. 

Methode 2: Auf [File] > [Save as...] klicken, um das Modell als Projektdatei im 
Format FPP, STL oder OBJ zu speichern. Bei den Dateiformaten STL und OBJ 
werden die Modelle in ein einziges Modell integriert (einschließlich der Stützen). 
Beim erneuten Laden dieser Dateiformate wird nur die Position des Modells 
gespeichert, die Druckparameter jedoch nicht. 

③ Preferences 
Auf [File] > [Preferences] Klicken. Hier kann die Sprache gewählt und die 
Suche nach vorhandenen Aktualisierungen beim Gerätestart festlegt werden. 

 

 

 

 

 

● Language: Die Software unterstützt die folgenden sechs Sprachen: 
Chinesisch (vereinfachtes und traditionelles), Englisch, Französisch, 
Koreanisch, Japanisch und Russisch. 

● Printing Window Type: Umfasst den Grundmodus und den Expertenmodus  

● Check for Update After Start Up: Über diese Einstellung können Sie 
festlegen, ob die automatische Online-Aktualisierung aktiviert werden soll. 
Wenn Sie „Yes“ wählen, kann die Software beim jedem Starten online prüfen, 
ob eine neue Softwareversion verfügbar ist und, sofern dies zutrifft, den 
Benutzer zum Herunterladen und Installieren der neuen Softwareversion 
auffordern. 
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6.2.12 Bearbeitungsmenüs 
① Undo 
Es stehen die folgenden beiden Möglichkeiten zur Verfügung, um die zuletzt 
vorgenommenen Änderungen rückgängig zu machen: 

Methode 1: Klicken Sie auf [Edit] > [Undo].  

Methode 2: Drücken Sie die Tastenkombination Strg+Z.  

② Redo 
Es stehen die folgenden beiden Möglichkeiten zur Verfügung, um die zuletzt 
rückgängig gemachte Änderung an der Modelldatei wiederherzustellen. 

Methode 1: Klicken Sie auf [Edit] > [Redo]. 

Methode 2: Drücken Sie die Tastenkombination Strg+Y. 

③ Empty Undo-Stack 

Über diese Funktion können Sie die gespeicherten Bearbeitungsschritte 
löschen, um Speicherplatz freizugeben. 

④ Select All  

Anhand der folgenden beiden Methoden können alle Modelle in der 
Bearbeitungsumgebung ausgewählt werden. (Wenn Modelle so klein sind, 
dass Sie sie nicht sehen können, oder sich außerhalb des Ansichtsbereichs 
befinden, klicken Sie auf die Schaltflächen [Center] und [Scale], um das 
Modell anzupassen.) 

Methode 1: Klicken Sie auf [Edit] > [Select All]. 

Methode 2: Drücken Sie die Tastenkombination Strg+A. 

⑤ Duplicate 

Objekt anhand einer der folgenden beiden Methoden dublizieren: 
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Methode 1: Auf [Edit] > [Duplicate] klicken. 

Methode 2: Tastenkombination Strg+D drücken. 

⑥ Delete 

Objekt anhand einer der folgenden beiden Methoden löschen: 

Methode 1: Auf [Edit] > [Delete] klicken. 

Methode 2: Die Taste Entf drücken. 

⑦ Surface to Platform 

Nachdem Sie das Modell ausgewählt haben, können Sie über den folgenden 
Vorgang die Modellfläche auf die Plattform auflegen. 

Klicken Sie auf [Edit] > [Surface to Platform], um in den Modus Fläche-Auf-
Plattform zu wechseln  

(wie in der folgenden Abbildung dargestellt). 

 

 

 

 

       

 

 

 

                       

 

 

⑧ Auto Layout All 
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Klicken Sie auf [Edit] > [Auto Layout All], nachdem Sie ein oder mehrere 
Modelle geladen haben. Daraufhin werden alle Modelle anhand der 
automatischen Platzierungsregel positioniert. 

 

6.2.13 Druckmenüs 
① Connect Machine 

Sie können den 3D-Drucker über ein USB-Kabel oder über W-LAN mit einem 
Computer verbinden. 

Hinweis: Das Gerätesymbol unten rechts gibt den Verbindungsstatus an:    

 
Verbunden 

 
Nicht verbunden 

Methode 1: Verbinden über ein USB-Kabel 

a. Verbinden Sie den 3D-Drucker über ein USB-Kabel mit einem Computer. 

b. Schalten Sie den 3D-Drucker ein, und starten Sie REXprint. 

c. Klicken Sie auf [Print] > [Connect Machine], wählen Sie unter [Connection 
Mode] den USB-Modus, und wählen Sie unter [Select Machine] das Gerät, mit 
dem Sie eine Verbindung herstellen möchten. Wenn Sie das gewünschte Gerät 
nicht finden können, klicken Sie auf die Schaltfläche [Rescan], um nach dem 
Gerät zu suchen. Wählen Sie das entsprechende Gerät dann aus. Klicken Sie 
abschließend auf die Schaltfläche [Connect], um eine Verbindung mit dem 
Drucker herzustellen. Wenn Sie das gewünschte Gerät auch nach einem 
erneuten Suchlauf nicht finden können, bedeutet dies, dass in der Software der 
entsprechende Treiber nicht installiert ist.  
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Methode 2: Verbinden über W-LAN 

① Herstellen einer Verbindung zwischen dem 3D-Drucker und einem 
Computer im AP-Modus 

a. Den 3D-Drucker einschalten. 

b. Auf [Tools] > [Setting] > [WIFI] > [WIFI ON] tippen. 

c. Unten rechts auf das Gerätesymbol klicken, um die W-LAN-Verbindung zu 
aktivieren. Das W-LAN-Signal „REX II“ wählen und auf [Connect] klicken, um 
die Netzwerkverbindung abzuschließen. 

d. In REXprint auf [Print] > [Connect Machine] klicken. Daraufhin wird das 
folgende Dialogfeld geöffnet. Für den Verbindungsmodus muss 
„WiFi“ ausgewählt werden. Die im Dialogfeld angezeigte IP-Adresse eingeben, 
und auf [Connect] klicken. 
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Wenn die Verbindung hergestellt wurde, wird das Gerätesymbol wie 
nachfolgend abgebildet unten rechts angezeigt. 

 

      

① Herstellen einer Verbindung zwischen dem 3D-Drucker und einem 
Computer im STA-Modus 

a. Aktivieren Sie das W-LAN des 3D-Druckers, und verbinden Sie den GuiderII 
über W-LAN mit einem Computer. Drücken Sie [ Tools ], [ Setting ], [ WIFI ] 
und [ WIFI ON]. 

b. Das Dauersignal für „REX II“ wird in der Netzwerkliste als verfügbar angezeigt. 

c. Nachdem die Verbindung zwischen dem Computer und dem 3D-Drucker 
hergestellt wurde, öffnen Sie den Internetbrowser und geben Sie 
„10.10.100.254“ sowie Standard-Benutzername (Administrator) und -
Kennwort (Administrator) ein. 

Die folgende Benutzeroberfläche für die W-LAN-Einstellungen wird geöffnet: 
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d. Legen Sie für den STA-Modus den W-LAN-Modus fest, und nehmen Sie die 
entsprechenden Einstellungen vor. Sie können die SSID (Name des W-LAN) 
und das Kennwort ändern, für das Abrufen der IP-Adresse unter DHCP die 
Option [Enable] wählen und dann auf [Save] klicken. Daraufhin wird das 
folgende Dialogfeld angezeigt. 
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e. Klicken Sie auf die Schaltfläche [Restart]. Ein Neustart des REX II W-LAN 
ist erforderlich. Nach dem Neustart stellt der 3D-Drucker über das eingerichtete 
W-LAN eine Verbindung mit dem Computer her. 

② Trennen der Verbindung mit dem 3D-Drucker 

Klicken Sie auf [Print] > [Disconnect], um die Verbindung zwischen dem 
Computer und dem 3D-Drucker zu trennen. 

6.2.14 Tool-Menüs 
① Control Panel 

Nachdem Sie eine Verbindung zwischen dem Computer und dem 3D-Drucker 
hergestellt haben, klicken Sie auf [Tools] > [Control Panel], um die 
Systemsteuerung zu öffnen.  

● Jog Controls 

a. Jog Mode: Wählen Sie den Abstand für eine einzelne Bewegung von 
Extruder/Druckplatte (d. h. den Abstand, um den sich der Extruder/die 
Druckplatte nach einem einzelnen Klick verschiebt). 

 

6-23 



 

 

 www.bresser.de  

 
68 

b. Sechs blaue Richtungspfeile: Über diese Schaltflächen können Sie die 
Bewegungen entlang der X-/Y-/Z-Achsen steuern. Über die Schaltflächen für die X-
/Y-Achsen steuern Sie die Bewegungen des Extruders, und über die Schaltflächen 
für die Z-Achse steuern Sie die Bewegung der Druckplatte. Wenn Sie auf „X-“ klicken, 
bewegt sich der Extruder um einen festgelegten Abstand nach links. Klicken Sie 
hingegen auf „X+“, bewegt sich der Extruder um einen festgelegten Abstand nach 
rechts. Klicken Sie auf „Y-“ bewegt sich der Extruder um einen festgelegten Abstand 
nach vorne, und durch ein Klicken auf „Y+“ bewegt sich der Extruder um einen 
festgelegten Abstand nach hinten. Wenn Sie auf die Schaltfläche „Z-“ klicken, bewegt 
sich die Druckplatte um einen festgelegten Abstand nach oben, und durch Klicken 
auf „Z+“ bewegt sich die Druckplatte um einen festgelegten Abstand nach unten. (Der 
festgelegte Abstand wird unter „Jog Mode“ festgelegt.) 

c. Stop: Klicken Sie auf die Schaltfläche [Stop], um die aktuelle Verschiebung 
abzubrechen. d. XYZ-Koordinatenrahmen auf der rechten Seite: Zeigt die 
aktuelle Position von Extruder/Druckplatte an. 

e. Schaltfläche „Make Current Position Zero“: Legen Sie für die aktuelle 
Position von  

Extruder/Druckplatte den Nullwert (0, 0, 0) fest. (HINWEIS: Die Felder „X“, 
„Y“ und „Z“ dienen nur zur Anzeige. Wenn Sie die Werte in diesen Feldern 
ändern, hat das keinerlei Wirkung.) 

f. Schaltflächen „Center X/Y/Z“: Extruder und Druckplattform nehmen die 
zuletzt festgelegten Nullwerte (0, 0, 0) ein. 

g. Einstellungen „X/Y Speed“ und „Z Speed“: Legen Sie über den 
Schieberegler die Geschwindigkeit für den Extruder und die Druckplattform fest. 

● Limit Switch: Damit der 3D-Drucker geschützt wird, gibt es drei 
Begrenzungsschalter zur Steuerung der Maximalposition, die als 
Begrenzungsschalter für die X-/Y-/Z-Achse dienen. Für die Schalter gibt es zwei 
Status: 

a. Not Triggered: Wenn sich Extruder und Druckplatte nicht bis zum maximal 
möglichen Punkt bewegen, sind die Begrenzungsschalter für die X-/Y-/Z-
Achsen nicht aktiviert, es wird der Status „Not Triggered“ angezeigt. 
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b. Triggered: Wenn sich Extruder und Druckplatte bis zum maximal möglichen 
Punkt bewegen, sind die Begrenzungsschalter für die X-/Y-/Z-Achsen aktiviert, 
es wird der Status „Triggered“ angezeigt. 

● Stepper Motor Controls: Über diese Elemente kann der Schrittmotor 
gesteuert werden. Klicken Sie auf [Enable], und sperren Sie den Motor, damit 
dieser keine Bewegungen ausführen kann. Klicken Sie auf [Disable], und 
heben Sie die Motorsperre auf, um den Motor manuell zu steuern. 

● LED Color: Über diese Schaltfläche können die LED-Farben des 3D-Drucker 
geändert werden. 

● Extruder Controls: Über die Steuerelemente für den Extruder können Sie 
den Wert für „Motor Speed (RPM)“ festlegen, d. h. die Drehgeschwindigkeit der 
Filament-Spule. Die Drehzeit des Motors kann über den Wert für „Extruder 
Duration“ festgelegt werden. Es wird ein Wert von 60 Sekunden empfohlen. 
Das Filament muss im Extruder geladen sein, bevor der Motor gestartet wird.  

HINWEIS:  
Den Betrieb nicht starten, bevor die Extrudertemperatur die 
Drucktemperatur des Filaments erreicht hat.  

Bei Verwendung von PLA-Filament sollte die Extrudertemperatur 200℃ 
betragen. Klicken Sie, wenn die Extrudertemperatur erreicht ist, auf die 
Schaltflächen [Forward]/[Reverse], um das Einsetzen/Entnehmen von 
Filament zu steuern. Wenn Sie das Einsetzen bzw. Entnehmen von Filament 
abbrechen möchten, können Sie auf die Schaltfläche [Stop] klicken. 

● Temperature Controls: Geben Sie die gewünschte Temperatur in das linke 
Feld ein und klicken Sie auf [Apply]. Der Drucker heizt das entsprechende Teil 
automatisch auf. Auf der rechten Seite wird die aktuelle Temperatur des 
jeweiligen Teils angezeigt. Nachdem der Aufwärmvorgang gestartet wurde, 
ändert sich die Form der unten dargestellten Temperaturkurve, und die 
unterschiedlichen Farben stellen die Temperaturen der jeweiligen Teile dar. 

② Update Firmware 
Bei jedem Start von REXprint wird automatisch geprüft, ob eine aktuellere 
Version der Firmware verfügbar ist und diese dann heruntergeladen. Sofern 
eine Aktualisierung vorhanden ist, wird der Benutzer in einem Popup-Fenster 
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über die verfügbare Aktualisierung informiert. 

Schritt 1: Klicken Sie auf [Tools] > [Update firmware]. Vor einer Aktualisierung 
der Firmware müssen alle bestehenden Verbindungen beendet werden. Sofern 
die Software und der Drucker bereits verbunden sind, werden Sie daran erinnert, 
dass die Verbindung beendet werden muss. Wählen Sie die Option [Yes], und 
fahren Sie mit dem nächsten Schritt fort. 

Schritt 2: Wählen Sie den entsprechenden Druckertyp und die Firmware-
Version, und klicken Sie dann im Feld für die Firmware-Aktualisierung auf [OK]. 
Wenn Sie bestätigt haben, dass der Drucker nicht im Einsatz ist, wird die 
aktuelle Firmware-Version automatisch aktualisiert. 

Schritt 3: Starten Sie den 3D-Drucker neu, und warten Sie 4-5 Sekunden. Dann 
wird die Fortschrittsleiste der Aktualisierung angezeigt. Nachdem die Aktualisierung 
abgeschlossen ist, wird automatisch wieder das Hauptmenü angezeigt. 

Schritt 4: Tippen Sie auf [Tools]--[About], um zu prüfen, dass die richtige 
Versionsnummer der aktualisierten Software angezeigt wird.  

③ On Board Preferences 
Wenn der Computer und der Drucker miteinander verbunden sind, können Sie 
den Druckernamen prüfen, indem Sie auf [Tools] > [On Board Preferences] 
klicken.  
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④ Machine Information 
Wenn der Computer und der Drucker miteinander verbunden sind, können Sie 
den Gerätetyp, den Gerätenamen, die Firmware usw. prüfen, indem Sie auf 
[Tools] > [Machine information] klicken. 

6.2.15 Hilfemenüs 
① Help Contents: Klicken Sie auf [Help] > [Help Contents], um die Inhalte 
der Hilfe zu lesen. 

② Check for Updates: Klicken Sie auf [Help] > [Check for Update], um online 
zu prüfen, ob Aktualisierungen verfügbar sind. 

③ About REXprint: Klicken Sie auf [Help] > [About REXprint]. Daraufhin 
öffnet sich das Feld mit den Informationen über die Software. In diesem Feld 
werden die aktuelle Softwareversion sowie die Informationen zum Urheberrecht 
angezeigt. 
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Kapitel 7:  
Grundlegende Druckfunktionen 
In diesem Kapitel wird schrittweise erläutert, wie Sie den Druck eines 3D-
Modells realisieren können. Es wird empfohlen, die Informationen der 
vorausgehenden Kapitel zum Einlegen/Entnehmen von Filament, zum 
Nivellieren der Plattform und zu den Funktionen von REXprint zu lesen, bevor 
Sie einen Druckvorgang starten. 

7.1 Erstellen einer Gcode-Datei 
(7-1) Doppelklicken Sie auf das REXprint-Symbol, um die Software aufzurufen. 

                                   7-1 

(7-2) Klicken Sie auf [Print] > [Machine Type], um Bresser REX II 
auszuwählen. 

(7-3) Klicken Sie auf das Symbol [Load], um eine STL-Modelldatei zu laden. 
Das Objekt wird im Druckbereich dargestellt. 

34 
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(7-4) Klicken Sie auf [Edit] > [Surface to Platform], um Ihr Modell optimal im 
Druckbereich zu positionieren. Klicken Sie auf [Back], und klicken Sie 
anschließend doppelt auf das Symbol Move und dann auf [On the Platform] 
und [Center], um sicherzustellen, dass sich das Modell auf der Plattform 
befindet. 

Hinweis: Wenn Sie das Modell in der richtigen Position platziert haben, 
können Sie den zuvor beschriebenen Schritt überspringen. 

(7-5) Klicken Sie oben auf das Symbol [Print]. Sie können die erforderlichen 
Einstellungen für Ihren Druckauftrag vornehmen. 

 
7-3 
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Preview: Wenn Sie das Feld [Preview] aktivieren, können Sie eine Vorschau 
Ihres Modells anzeigen, nachdem dieses in Scheiben geschnitten wurde. 

Print when Slice Done: Wenn Sie über ein USB-Kabel drucken, können Sie 
dieses Feld aktivieren, damit das Modell gedruckt wird, sobald es in Scheiben 
geschnitten ist. Beim Drucken über USB wird die Auswahl dieser Option nicht 
empfohlen. 

Machine Type: Bresser REX II 

Supports: Wenn Sie ein Modell mit Stützen drucken, sollten Sie auf das nach 
unten weisende Dreieck klicken und die Option [Enable] auswählen. 

Raft: Es wird empfohlen, diese Option für eine Grundplatte über [Enable] zu 
aktivieren. 

Resolution: Für die Auflösung wird empfohlen, die Option [Standard] 
auszuwählen. 

More Options: Unter den weiteren Optionen empfiehlt es sich, die 
Standardeinstellungen beizubehalten. 

Klicken Sie auf [OK], um den Pfad zum Speichern der Gcode-Datei 
auszuwählen. Sie können die Datei beliebig benennen und für das Dateiformat 
G oder GX festlegen. Klicken Sie auf [Save], um eine Gcode-Datei zu erstellen. 

 

7-5 



 

 

 www.bresser.de  

 
75 

 7-6 

Hinweis: Für GX-Dateien kann eine Vorschau angezeigt werden, für G-Dateien 
hingegen nicht. Die Dateien werden wie folgt dargestellt: 

 

 

   

 

 

          G-Dateien                              GX- Dateien 

7-7                           

Als Nächstes erfahren Sie, wie Sie ein Modell drucken. 

7.2 Druckmethoden 
Nachdem Sie die Gcode-Datei erstellt haben, können Sie diese an den 3D-
Drucker übertragen. Für die Übertragung der Datei können Sie ein USB-Kabel 
oder einen USB-Stick nutzen. 

7.2.1 Drucken vom Computer  
(USB-Verbindung) 
① Verbinden Sie den 3D-Drucker über ein USB-Kabel mit dem Computer. 

② Schalten Sie den 3D-Drucker ein, passen Sie die Höhe der Druckplatte an 
und setzen Sie das Filament ein. 

③ Klicken Sie auf [Print], und übertragen Sie die Gcode-Datei an den 3D-
Drucker. Nachdem die Übertragung abgeschlossen ist, wärmt sich der Drucker 
automatisch auf. Nach Abschluss des Aufwärmvorgangs beginnt der Drucker 
mit dem Erstellen des Modells. 
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④ Wenn Ihr Computer mit REXprint verbunden ist, können Sie im Statusfeld 
unten rechts die Düsentemperatur in Echtzeit sehen. Nachdem der 
Aufwärmvorgang abgeschlossen ist, startet der Drucker unmittelbar den 
Druckauftrag. 

7.2.2 Drucken vom Computer  
(W-LAN-Verbindung) 
① Verbinden Sie den 3D-Drucker über W-LAN mit dem Computer. (Vgl. 
Abschnitt 6.1.13) 

② Schalten Sie den 3D-Drucker ein, passen Sie die Höhe der Druckplatte an 
und setzen Sie das Filament ein. 

③ Klicken Sie auf [Print], und übertragen Sie die Gcode-Datei an den 3D-
Drucker. Nachdem die Übertragung abgeschlossen ist, wärmt sich der Drucker 
automatisch auf. Nach Abschluss des Aufwärmvorgangs beginnt der Drucker 
mit dem Erstellen des Modells. 

Wenn Sie eine Gcode-Datei aus einem lokalen Ordner drucken möchten, 
müssen Sie die Datei einfach über eine USB- oder W-LAN-Verbindung in 
REXprint laden und anschließend auf die Schaltfläche [Print] oben rechts 
klicken. 
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● Laden Sie die gewünschte Gcode-Datei in REXprint 

 

 

 

 

 

 

 

 

 

 

● Klicken Sie auf die Schaltfläche [Print]. Der Computer überträgt die Gcode-
Datei an den Drucker. 

● Nachdem die Übertragung abgeschlossen ist, wärmt sich der Drucker 
automatisch auf. Nach Abschluss des Aufwärmvorgangs beginnt der Drucker 
mit dem Erstellen des Modells. 

7.2.3 Drucken vom USB-Flashlaufwerk 
① Stecken Sie das USB-Flashlaufwerk, auf dem sich die gewünschte G- oder 
GX-Datei befindet, am 3D-Drucker ein. 

② Schalten Sie den 3D-Drucker ein. Stellen Sie sicher, dass die Höhe der 
Druckplatte entsprechend angepasst und Filament eingesetzt ist. 

③ Tippen Sie auf [Print] und anschließend auf das Symbol SD Card in der 
Mitte. Die Datei(en) werden auf dem Touchscreen angezeigt. Wählen Sie die 
gewünschte Datei, und tippen Sie auf [Print]. Die Datei wird an den Drucker 
übertragen.  

⑥ Der Drucker startet den Aufwärmvorgang der Düse automatisch, und der 
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Druckvorgang beginnt, wenn die Düse die festgelegte Temperatur erreicht hat. 

 

Abort: Zum Stoppen des Aufwärmvorgangs und des Druckens. Wenn Sie auf 
[Abort] tippen, wird der Vorgang unwiderruflich abgebrochen. 

Pause: Zum Anhalten des Druckauftrags, zum Wiederaufnehmen erneut 
antippen. Diese Funktion ist hilfreich, wenn Sie während des Druckauftrags das 
Filament wechseln möchten. 
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Kapitel 8:  
Erweiterte Druckfunktionen 

Wenn Sie mit den grundlegenden Funktionen des 3D-Drucker vertraut sind, 
möchten Sie sicherlich die erweiterten Druckfunktionen nutzen, die Ihnen zur 
Verfügung stehen. In diesem Kapitel werden eben diese erweiterten 
Druckfunktionen beschrieben. 

Im Expertenmodus bestehen mehr Möglichkeiten zum Bearbeiten der 
Parameter. Es kann zwischen zwei Modi gewählt werden: „Basic Mode“ und  
„Expert Mode“. 

 

 

 

 

 

 

 

 

 

 

8-1 

Select Profile: Über diese Option kann das erforderliche Schema ausgewählt 
werden. Es stehen drei Optionen zur Verfügung (low/standard/high). 
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Standardmäßig ist PLA festgelegt. Die unterschiedlichen Schemata 
entsprechen den unterschiedlichen Parametereinstellungen. Das Schema für 
hohe Qualität erzeugt Objekte mit hoher Auflösung, zieht jedoch eine langsame 
Verarbeitungsgeschwindigkeit nach sich. Das Schema für geringere Qualität 
erzeugt hingegen Objekte mit geringer Auflösung und zeichnet sich durch eine 
schnelle Verarbeitungsgeschwindigkeit aus. Beim Druck mit PLA steht den 
Benutzern noch die Option „Hyper“ zur Verfügung. 

 

General 
 

1) Layer Height 

a. Layer Height: Schichtstärke. Je geringer die Schichtstärke, desto länger die  
Druckzeit und umso besser die Druckqualität.  

b. First Layer Height: Beim Druck mit geringer Schichtstärke verbessert eine 
dickere erste Schicht die Haftung und Toleranz bei Druckplattformen, die u. U. 
Abnutzungen aufweisen. 

2) Speed 

a. Base Print Speed: Der Referenzwert für die Geschwindigkeit, mit der sich der 
Extruder während des Druckvorgangs bewegt (für nachfolgende Berechnung 
der Druckgeschwindigkeit). Bei einer geringeren Geschwindigkeit kann der 
Drucker Objekte mit einer höheren Auflösung und einer glatteren Oberfläche 
erstellen. 

b. Travel Speed: Geschwindigkeit, mit der sich der Extruder bewegt, wenn kein 
Filament aufgetragen wird. 

c. Minimum Speed: Die Mindestgeschwindigkeit, mit der sich der Extruder 
während des Druckens bewegt. 

d. First Layer Maximum Speed: Die maximale Druckgeschwindigkeit für die 
erste Schicht (Hinweis: Diese Einstellung entfällt, wenn das Modell über eine 
Grundplatte verfügt.) 

d. First Layer Maximum Travel Speed: Die maximale Geschwindigkeit des 
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Extruders beim Druck der ersten Schicht, wenn kein Filament aufgetragen wird 
(Hinweis: Diese Einstellung entfällt, wenn das Modell über eine Grundplatte 
verfügt.) 

3) Temperature 

Es wird die Temperatur für den „Extruder“ angezeigt. 

4) Retraction 

a. Retraction Length: Der Wert für den Rückzug. Durch die Rückzugfunktion 
kann das Fädenziehen oder Herausquellen während des Druckens vermieden 
werden. (Empfohlen wird der Standardwert.) 

b. Speed: Die Geschwindigkeit, mit der das Filament zurückgezogen wird. 
Empfohlen wird der Standardwert. 

    

Perimeter 
 

1）Thickness 

a. Shell Count: Die Anzahl an Runden für die Hülle jeder Schicht. Maximale 
Anzahl: 10; Mindestanzahl: 1. 

b. Maximum Path Overlap: Die maximale Überlappung des Auftrags für 
bestimmte Modelle, insbesondere kleine Modelle.  

2) Speed 

a. Exterior Speed: Die Geschwindigkeit, mit der die Außenhülle gedruckt wird.  

b. Visible Interior Speed: Die Geschwindigkeit, mit der die sichtbare Innenhülle 
gedruckt wird.  

c. Invisible Interior Speed: Die Geschwindigkeit, mit der die nicht sichtbare 
Innenhülle gedruckt wird.  

3) Start Points 

a. Mode: Es gibt zwei Optionen für den Modus „Start Point“. Die eine Option 
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lautet „closest to specific location“, was dem der angegebenen Position am 
nächsten gelegenen Punkt entspricht, und die andere lautet „use random start 
points“, was die Verwendung zufälliger Anfangspunkte bedeutet. 

b. „X“: Der Koordinatenwert für X. 

c. „Y“: Der Koordinatenwert für Y. 

  

Infill 

1) General 

a. Top Solid Layer: Anzahl an festen Schichten auf der Oberseite des Modells. 

a. Bottom Solid Layer: Anzahl an festen Schichten auf der Unterseite des 
Modells. 

c. Fill Density: Bestimmt die innere Festigkeit des Modells. 

d. Fill Pattern: Über diese Option wird das Füllmuster für das Innere des Teils 
festgelegt. Eine Hexagon-Füllung weist eine höhere Festigkeit auf, und eine 
Line-Füllung nimmt weniger Druckzeit in Anspruch. 
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e. Start Angle: Der Winkel der ersten Füllschicht. 

f. Overlap Perimeter: Die Breite, in der sich die Füllung und die Hülle überlappen.  

g. Vase Mode: Wenn diese Option ausgewählt ist, werden keine innere Füllung 
und obere feste Füllung gedruckt. (Diese Option hat eine Füllung von 0 % mit 
einem einzelnen Perimeter zur Folge.) 

2) Speed 

a. Solid Speed: Geschwindigkeit, in der untere/obere Teile gedruckt werden. 

b. Sparse Speed: Geschwindigkeit, in der die Füllung gedruckt wird. 

3) Combine Infill 

a. Maximum Combine Layers: Wählen Sie die Anzahl an Schichten 
entsprechend der Höhe der Schicht. Die Gesamthöhe sollte nicht größer als 
0,4 mm sein. 

b. Combine Mode: Umfasst die Modi „Sparse and Solid“ und „Sparse Only“. Der 
Modus „Sparse Only“ kann nur für die Schichten der inneren Füllung genutzt 
werden. 
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Supports 
 

2) General 

a. Enable Support: Die Stützenoption aktiviert bzw. deaktiviert werden. Eine 
Stützstruktur kann verhindern, dass ein Modell zusammenbricht. Wenn Sie die 
Einstellung „Yes“ wählen, können Sie Stützen im Baumformat oder im linearen 
Format verwenden. Wenn Sie die Einstellung „No“ wählen, können weder 
Stützen im Baumformat noch im linearen Format festgelegt werden.  

3) Treelike 

a. Speed: Geschwindigkeit, mit der Stützen im Baumformat gedruckt werden. 

b. Space to Model (X/Y): Der Abstand zwischen den Stützen im Baumformat 
und der Kontaktoberfläche des Modells (für die X-/Y-Richtungen). 

c. Shell Count: Steuern der Druckrundenanzahl für die Außenhülle der Stützen. 

2）Linear 

a. Speed: Geschwindigkeit, mit der Stützen im linearen Format gedruckt werden. 
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b. Space to Model (X/Y): Der Abstand zwischen den Stützen im linearen Format 
und der Kontaktoberfläche des Modells (für die X-/Y-Richtungen). 

b. Space to Model (Z): Der Abstand zwischen den Stützen im Baumformat und 
der Kontaktoberfläche des Modells (für die Z-Richtung). 

d. Path Space: Der Abstand zwischen den angrenzenden Pfaden. 

 

Raft 

1) General 

a. Enable Raft: Aktivieren Sie diese Option, um während des Druckvorgangs 
eine Grundplatte zu drucken. Durch eine Grundplatte wird die Haftung des 
Modells auf der Druckplatte verbessert. 

b. Margin: Der Abstand zwischen der Außenlinie der Grundplatte und der 
Außenlinie der ersten Modellschicht. Wenn die Option für die Grundplatte 
aktiviert ist, wird der zusätzliche Bereich für die Grundplatte um das Objekt 
herum ebenfalls aktiviert. Wenn Sie den Rand vergrößern, wird eine solidere 
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Grundplatte erstellt und dafür mehr Material verbraucht, und gleichzeitig 
verbleibt weniger Platz für das Objekt. 

b. Space to Model (Z): Der Abstand zwischen der Oberseite der Grundplatte 
und der ersten Modellschicht. 

 

Additions 

1) Pre-extrusion 

a. Enable Pre-extrusion: „Yes“ wählen, damit der Extruder einen Vor-Auftrag 
aufbringen kann, bis .  

b. Space to Model: Der maximale Abstand zwischen dem vorab aufgetragenen 
Filament und der ersten Modellschicht. 

c. Path Length: Die Filament-Länge für den Vor-Auftrag. 

d. Speed: Die Druckgeschwindigkeit für den Vor-Auftrag. 
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3）Wall 

a. Enable Wall: Aktivieren Sie diese Option, damit der Extruder während des 
Druckvorgangs eine Wand drucken kann. Durch Aktivieren der Wandfunktion 
kann das Fädenziehen oder Herausquellen bis zu einem gewissen Grad 
vermieden werden. 

b. Shell Count: Zum Steuern der Anzahl an Druckrunden für die Hülle der 
Stützen. 

c. Space to Model: Der Mindestabstand zwischen der Wand und dem Modell. 

d. Speed: Die Geschwindigkeit, mit der die Wand gedruckt wird. 

 

 
Advanced 

 

1）Stepper Motor Voltage (es wird empfohlen den Standardwert 
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beizubehalten) 

a. X-Axis: Spannungsparameter des Schrittmotors der X-Achse. Je höher der 
Wert ist, umso größer ist die Wärmebildung. 

b. Y-Axis: Spannungsparameter des Schrittmotors der Y-Achse. Je höher der 
Wert ist, umso größer ist die Wärmebildung. 

c. Z-Axis: Spannungsparameter des Schrittmotors der Z-Achse. Je höher der 
Wert ist, umso größer ist die Wärmebildung. 

d. A-Axis: Spannungsparameter des Schrittmotors des rechten Extruders. Je 
höher der Wert ist, umso größer ist die Wärmebildung. 

e. B-Axis: Spannungsparameter des Schrittmotors des linken Extruders. Je 
höher der Wert ist, umso größer ist die Wärmebildung. 

2) Others 

a. Extrusion Ratio: Die Menge an Filament, die vom Extruder ausgegeben wird. 
Default: 109 % Max: 125 % (Das Standardverhältnis wird empfohlen)   

b. Path Width: Die Breite des Pfads, der Standardwert ist auf 0,4 mm festgelegt. 
Es wird empfohlen, den Standardwert beizubehalten. 

c. Path Resolution: Der Standardwert ist auf 0,1 mm festgelegt. Je höher der 
Wert ist, desto geringer ist die Auflösung des Auftrags. Umgekehrt führt ein 
niedrigerer Wert zu einer höheren Auflösung des Auftrags.  
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Others 
 

1) Dimensional Adjustments 

a. Enable Adjustments: Wenn Sie diese Option aktivieren, kann die Software 
Fehleranpassungen vornehmen. 

b. External Compensation: Wenn Sie diese Option aktivieren, kann die Software 
Anpassungen für Fehler am äußeren Durchmesser vornehmen. 

c. Internal Compensation: Wenn Sie diese Option aktivieren, kann die Software 
Anpassungen für Fehler am inneren Durchmesser vornehmen. 

Save as new 

Über diese Option kann das Modell nach Parameteränderungen in einer neuen 
Datei gespeichert werden. Dazu folgendermaßen vorgehen: 

Nachdem alle erforderlichen Parameter geändert wurden, klicken Sie auf [Save 
as new]. Daraufhin wird ein Dialogfeld geöffnet. In diesem Feld muss man einen 
Dateinamen eingeben und anschließend auf [OK] klicken. Klicken Sie auf das 
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Dropdown-Menü von [Select profile]. Das neu hinzugefügte Schema wird in 
der Liste aufgeführt. 

Remove 

Über diese Option können die hinzugefügten Schemata gelöscht werden. 
Wählen Sie eines der hinzugefügten Schemata, und klicken Sie auf [Remove]. 
Es öffnet sich daraufhin ein Dialogfeld, in dem Sie den Vorgang bestätigen 
können. Klicken Sie auf [Yes], um das Schema zu löschen, oder klicken Sie auf 
[No], um den aktuellen Vorgang abzubrechen. 

Restore Defaults: Über diese Option können die Standardwerte 
wiederhergestellt werden. 

Save Configuration: Über diese Option kann die aktuelle Konfiguration 
gespeichert werden. 

 

8.1 Wissenswertes zu Stützen 
(Referenzvideo: Wissenswertes zu Stützen) 
Wenn Sie Modelle mit steilen Überhängen und freitragenden Bereichen drucken 
möchten, benötigen Sie Stützstrukturen. Der 3D-Drucker nutzt die FFF-
Technologie (Schmelzschichtung), die auf dem Prinzip der additiven Herstellung 
beruht, d. h. dem Erwärmen und schichtweisen Auftragen von Material zum 
Erstellen eines Objekts. Bei vielen 3D-Druck-Modellen muss eine 
Materialschicht aufgetragen werden, wo sich noch keine Schicht befindet, oder 
die Modelle weisen spitze Winkel auf, die beim Druckvorgang zu einer 
unerwünschten Tropfenbildung führen könnten. In solchen Fällen sind 
Stützstrukturen erforderlich, damit ein ordnungsgemäßer Druck und die 
gewünschte Druckqualität sichergestellt werden können. 

① Das 45-Grad-Prinzip 
Grundsätzlich lässt sich festhalten, dass für 3D-Modelle mit einem Überhang 
von mehr als 45º Stützen erforderlich sind. Dieser Winkel ergibt sich aus dem 
Material, der Höhe der Schicht, der Auftragsbreite und der Temperatur. Es ist 
besonders wichtig, die Stützstrukturen entsprechend anzupassen, um ein 

http://v.youku.com/v_show/id_XMTY5MjAxOTE0NA==.html?f=27948825&from=y1.7-3
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optimales Druckergebnis zu gewährleisten, insbesondere bei großen 3D-
Drucken. Das Prinzip wurde von einem Bühnenbildner eingeführt und ist in der 
3D-Druckindustrie weitreichend etabliert.  

② Das Prinzip der Verhältnismäßigkeit 
Neben dem Erfordernis von Stützen sollte außerdem das Prinzip der 
Verhältnismäßigkeit berücksichtigt werden. Obgleich im Bereich des 
Stützenalgorithmus eine Weiterentwicklung stattgefunden hat, ist ein 
intelligentes Hinzufügen von Stützen derzeit noch nicht möglich. Daher müssen 
sich die Benutzer beim Hinzufügen von Stützen ihre eigenen Gedanken machen. 
Erfahrungen zeigen, dass das Entfernen der Stützen schwierig wird, wenn zu 
viele Stützen verwendet werden, zu wenig Stützen können auf der anderen 
Seite zu einer Instabilität des Modells führen. Da REXprint eine Funktion zur 
manuellen Anpassung bietet, können die Benutzer ihren Anforderungen und 
Erfahrungen entsprechend die geeignete Anzahl an Stützen hinzufügen.  

Stützentypen 
Lineare Stützenform: Dieser Stützentyp ist geeignet für Modelle mit 
großflächigen Überhängen. 

Funktionalität: Eine vollständige Abstützung verbessert die Modellstabilität. Es 
ist jedoch nicht so einfach, die Stützen von der Oberfläche zu entfernen, und 
das wirkt sich negativ auf die Druckqualität aus.  

Stützen im Baumformat: Dieser Stützentyp ist für Modelle geeignet, die kleine 
Überhänge aufweisen. (Für solche Modelle empfiehlt sich der Druck einer 
Grundplatte.) 

Funktionalität: Für diesen Stützentyp wird weniger Stützenmaterial benötigt, 
und sie können einfach entfernt werden. Im Vergleich zum linearen Stützentyp 
bieten die Stützen im Baumformat jedoch eine geringere Stabilität. Daher 
empfiehlt es sich, nach der automatischen Erstellung der Stützen im 
Baumformat ggf. weitere Stützen manuell hinzuzufügen. 

② Automatische Stützen 
Beispiel 1: Modell mit großflächigem Überhang  



 

 

 www.bresser.de  

 
92 

 

 

Richtig: Stützen im Baumformat 
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Falsch: Lineare Stützenform 

Beispiel 2: Modell mit kleinem Überhang  

 

 

Richtig: Stützen im Baumformat 
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Falsch: Lineare Stützenform 

 

Manuelle Anpassung 
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8-9 

Für erfahrene Benutzer von 3D-Druckern empfiehlt es sich, mithilfe der 
Schaltflächen [Add] und [Delete] Stützen manuell hinzuzufügen bzw. zu 
entfernen. 

1) Manuelles Hinzufügen 

  

           8-10 

Sie können passend zur Form des Modells die Stützstruktur manuell hinzufügen.   
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Klicken Sie mit der linken Maustaste auf der linken Seite auf [Add], und klicken 
Sie dann auf die Position, an der eine Stütze erforderlich ist. Halten Sie die linke 
Maustaste gedrückt und ziehen Sie, um die Stütze zu erstellen.  

 

2) Manuelles Löschen 



 

 

 www.bresser.de  

 
97 

                              8-11 

Wie im oben dargestellten Bild werden für ein Loch im Modell keine Stützen 
benötigt. 

Klicken Sie mit der linken Maustaste auf die Schaltfläche [Delete], und klicken 
Sie dann mit der linken Maustaste auf die Stützen, die Sie entfernen möchten. 
Diese Stützen werden daraufhin entfernt. 

 

8.2 Steuern der Druckqualität 
① Verbessern des Haftvermögens der Druckplatte 
● Die Druckplatte nivellieren 
● Die Druckplatte sauber und ordentlich halten 
● Druckfolie oder Kleber verwenden 

② Anpassen der Druckgeschwindigkeit 
● Low (Fast) (Druckgeschwindigkeit: 80 mm/s, Bewegungsgeschwindigkeit 
ohne Auftrag: 100 mm/s) 
● Standard (Druckgeschwindigkeit: 60 mm/s, Bewegungsgeschwindigkeit ohne 
Auftrag: 80 mm/s) 
● High (Slow) (Druckgeschwindigkeit: 50 mm/s, Bewegungsgeschwindigkeit 
ohne Auftrag: 70 mm/s) 
● Hyper (Druckgeschwindigkeit: 50 mm/s, Bewegungsgeschwindigkeit ohne 
Auftrag: 70 mm/s) 
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8.3 Wissenswertes zur Modellplatzierung 
Nicht alle Modelle befinden sich nach dem Laden an der richtigen Position. 
Daher müssen Sie das Modell an einer geeigneten Position platzieren, um eine 
bessere Druckqualität zu erzielen. Wie bei den im Folgenden dargestellten 
Modellen muss eine der Flächen auf der Plattform aufliegen. (Vergleiche auch 
5.1.12 - ⑦ Surface to Platform) 

① Skulptur/Büste – Ebene Plattform anlegen 

 

② Becher-Form – Öffnung oben 

 

   

                 Falsch                             Richtig 

                                     

  

Falsch                              Richtig 
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③ Konische Form – Schmalere Fläche unten   

 

  

  

Falsch                              Richtig 
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Weitere Informationen: Schneidefunktion 
 

Klicken Sie mit der linken Maustaste auf das Modell, um es auszuwählen, und 
doppelklicken Sie dann auf das Symbol „Cut“, um die Schnittebene festzulegen. 
Richtung und Position können festgelegt werden. 

Beispiel: 

Für große oder unregelmäßige Modelle empfiehlt es sich, diese in mehrere Teile 
zu schneiden, um bestehende Druckbeschränkungen zu umgehen und auf 
diese Weise eine bessere Druckqualität zu erzielen. Sehen Sie sich das Modell 
im Folgenden an:  

In Abbildung 8-15 wird die Vorschau der ursprünglichen Platzierung eines 
Modells dargestellt, und in Abbildung 8-16 wird das Modell mit Stützstrukturen 
gezeigt. 

                           

(8-16) Modell mit Stützstruktur 
 

 

 

 

 

 

 

8-15 

 

 

 

8-16 



 

 

 www.bresser.de  

 
101 

                      

Wenn Sie die Abbildung 8-16 betrachten, werden Sie feststellen können, dass 
sich die komplexen Stützstrukturen auf die Glätte des Modells auswirken. Nach 
einer Analyse der Merkmale des Modells empfiehlt sich ein Schneiden an der 
Y-Ebene (8-17).   

 

                             

 (8-18) Die Vorschau des Modells nach dem Schneiden. 

 

 

 

 

 

 

                                 

(8-19) Klicken Sie [Edit]--[Surface to Platform], um die ebenen Flächen auf 
die Plattform aufzulegen. 

 

8-18 

 

8-17 
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Vergleich 
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Kapitel 9: Garantie und Service 
 

Garantie 
 

Die Garantiezeit für dieses Gerät beträgt 5 Jahre und beginnt am Tag des Kaufs.  

Bitte bewahren Sie den Kaufbeleg (Kassenbon/Rechnung) als Nachweis für 
den Kauf sorgfältig auf. 

Während der Garantiezeit werden defekte Geräte vom Händler vor Ort 
angenommen oder ggf. von Ihnen direkt eingeschickt. Die Übersendung muss 
auf jeden Fall auf Ihre Kosten erfolgen. Im Garantiefall werden Ihnen die 
Portokosten erstattet. Sie erhalten dann ein neues oder repariertes Gerät 
kostenlos zurück. Die Entscheidung, ob eine Reparatur oder ein Tausch des 
Gerätes erfolgt, obliegt uns. 

Ausgenommen von dieser Garantie sind Zubehör-/Bauteile wie z.B. 
Aufnahmeplatten und -folien, Acrylglas-/Kunststoffelemente, USB-
/Wechselspeichermedien, Filaments und -Spulen, Kleber, Harze/Fette, Gefäße 
und Behälter, Werkzeuge etc. 

Die Garantie erlischt, wenn am Kaufgegenstand entstandene Mängel auf 
folgende Umstände zurückzuführen sind: 

 • nicht sachgemäße Benutzung 

 • fahrlässige oder vorsätzliche Beschädigung durch Eigenverschulden 
und/oder nicht authorisierte Dritte 

• Reparaturen oder Abänderungen, die von fremder Seite ohne unsere 
Beauftragung vorgenommen wurden 

• Veränderungen oder Beschädigungen infolge höherer Gewalt (Unwetter, 
Hagel, Feuer, Stromausfall, Blitzschlag,  

Überschwemmung, Schneeschaden, Frosteinwirkung und sonstige Einwirkung 
durch Tiere, usw.) 
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Die Garantie erlischt ferner, wenn ein beschädigter und/oder unleserlicher oder 
unvollständiger Kaufbeleg vorgelegt wird. 

Die Rechte aus der Garantie bestehen unabhängig von den gesetzlichen 
Gewährleistungsansprüchen. 

Garantiegeber ist die BRESSER GmbH, Gutenbergstr. 2, 46414 Rhede, 
Deutschland. 

Nach Ablauf der Garantiezeit haben Sie ebenfalls die Möglichkeit, ein defektes 
Gerät zwecks Reparatur zu übersenden. Nach Ablauf der Garantiezeit 
anfallende Reparaturen sind kostenpflichtig. Sie erhalten vor Ausführung der 
Reparatur einen Kostenvoranschlag von uns. 

Im Falle einer Retoure beachten Sie bitte Folgendes: 

Achten Sie darauf, dass der Artikel sorgfältig verpackt verschickt wird. Nutzen 
Sie nach Möglichkeit die Originalverpackung. Füllen Sie das Service-Formular 
aus und legen Sie dieses zusammen mit dem Kaufbeleg der Sendung bei. 

 

Service 
 

Sie können sich an das BRESSER Service-Team wenden, wenn Sie Probleme 
mit dem 3D-Drucker haben. Falls Fragen oder Probleme in diesem Handbuch 
nicht behandelt werden, können Sie auf unserer offiziellen Website nach 
Lösungen suchen oder sich telefonisch an uns wenden. 

In unserer Knowledge Base werden Lösungen und Anweisungen für häufig 
auftretende Probleme zur Verfügung gestellt. Es empfiehlt sich, dort als Erstes 
nach einer Lösung zu suchen, da die häufigsten Fragen dort beantwortet 
werden. 

http://www.bresser.de   

Email：service.3d-printer@bresser.de 

http://www.bresser.de/
mailto:service.3d-printer@bresser.de
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Sie erreichen das BRESSER Service-Team telefonisch oder per E-Mail von 
Montag bis Samstag, 8:30-15:30 Uhr (MEZ),. Sollten Sie sich außerhalb dieser 
Geschäftszeiten an uns wenden, beantworten wir Ihre Anfrage am folgenden 
Arbeitstag. 

Hinweis: Aufgrund von unterschiedlichem Filament kann der Extruder 
blockiert werden. Dieses Problem stellt kein Qualitätsproblem dar und 
liegt außerhalb des Bereichs von 400 Stunden Betriebszeit. Sofern dieses 
Problem auftritt, wenden Sie sich bitte an den Kundendienst und führen 
eine Reinigung nach den Anweisungen durch, die Sie dort erhalten. 
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